Arial Wi-Fi Nurse Call Solution

3. After activation the pendant enters Standby mode. The alarm will be issued
whenever the call button is pressed.

Calling for Assistance
1. Press the button (1) to call for help.
2. The Pendant emits an audio tone and the LED blinks red until a staff member
comes to assist the resident and physically dismiss the alarm.

Flashing Red
f . 2 LED

| Pendant in
Alarm Mode

Clearing an Alarm from a Pendant

IMPORTANT: Before dismissing an alarm, a staff member must attend to
the resident and dismiss the alarm form the Pendant.

The alarm can be dismissed with a secured dismiss sequence, as follows:

1. Double click the Pendant’s call button, and wait for the red LED to turn off, the
beep to sound and the green LED to light momentarily.

2. Double click the call button a second time (within 2 seconds). The Pendant
emits a tone, indicating the alarm has been dismissed.

3. The alarm is automatically dismissed in Arial.

This sequence returns the Pendant to Standby Mode and sends a ‘Reset’ message to
Arial

Specifications: P10 Wi-Fi Resident Pendant Tag (Model: TAG-P1000)

Physical and Mechanical Dimensions (including flange). 67 mm x 35 mm
x 14 mm (2.64 in x1.38 in x 0.58 in)

Weight: 33 g (1.15 0z)

Radio 802.11 b/g/n compliant (2.4 GHz)

Low frequency receiver for chokepoint
detection (125 kHz)

Transmission power: Up to +19dBm (Y81mW)
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Patented clear channel sensing avoids
interference with wireless networks

Programmability

Transmission interval configurable
Channel programmable

Over-the-Air configuration and firmware
upgrades

Environmental

Operating temperature: 0°C to 49°C (32°F to
120°F)

Humidity: O to 93%, non-condensing

Ingress Protection Rating: IP-67

Electrical

1200mAh, 3.0V replaceable Lithium Manganese
Dioxide battery*

Battery life: From 1to 3 years, depending on
use case, configuration, and infrastructure

* Use only approved batteries (e.g., STANLEY
Healthcare part # TAC-P1030)

Certification and
Regulatory Compliance

Radio:
FCC Part 15, sub-part C class B, sub-part B

EN 300-328, EN 300-330, EN 301-489, RSS 210
(Canada)

Safety:
CE, cTUVus (EN60950) « EN 60601-1-Rev3
UL2560, UL1069

Supplemental Hardware Components

The supplemental hardware components may already exist in a facility from a
previous Arial deployment or can be optionally added.

The following supplemental components are described in this section:

e Display Sign
e Paging Base Station
e Arial Pager
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NOTE: Serial devices such as paging transmitters and LED display signs
may be connected to the Arial nurse call network using a 2560-54312
Network Manager. A second network interface card is provided with
the server PC in the 2560-54370 bundle for the purpose of connecting
the Arial Wi-Fi Wireless Call System to a different network (such as the
facility network) in order to communicate with other supplemental
devices or third-party systems and applications.

WARNING! — EQUIPMENT THAT IS CONNECTED TO THE SYSTEM IS NOT
CONSIDERED TO BE PART OF THE LISTED SYSTEM CONFIGURATION
UNLESS THE EQUIPMENT IN QUESTION COMPLIES WITH THE STANDARD
FOR HOSPITAL SIGNALING AND NURSE CALL EQUIPMENT, UL1069.

Display Sign

Model Comments / Version

SKU: 54140 Networked Display Sign

The remote display gives staff the ability to view nurse calls while going about their
normal care routine. When a resident summons for help, remote displays provide
programmable information about the resident’s apartment number, name and/or the
device type used to call for help. Messages are cleared automatically when staff
members respond to a call. Remote notification options help to maximize staff
efficiency and speed staff response time. Due to their high visibility, they can be
considered the equivalent to lights above doors in skilled nursing facilities.

Signs have three colors (red, green, and amber) and sixteen scroll modes. The Event
Categories features of Arial are used to make different types of alarms appear in
different colors. Escalation (which is setup in the ‘Zone’ area of the software) causes
messages on the signs to change to a different scroll mode to indicate that the alarm
has been going off longer than newer alarms on the sign.

Signs connect to Arial via a network connection and an IP to RS232 converter located
at the sign. One-off messages can be sent manually from the software to an individual
sign or pager at any time.

Signs may be mounted on a ceiling, wall or a flat work surface using the included
hardware.
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Figure 25. Display Sign

Specifications: Display Sign
Physical and Mechanical Dimensions: 28.9” x 3.3” x 4.5” (73.5 x 8.4 x 11.5
cm)

Display Dimensions: 2.1” x 27” (5.3 x 68.5 cm),
Character size: 2.1” (5.3 cm)

Weight: 6.25 Ibs. (2.8 kg), includes display and
external power supply

Power 120 VAC+ 10% (Optional 220 VAC)

Characters Displayed 15 maximum (single line)

Message Capacity 26 different messages can be stored and
displayed

Paging Base Station

Model Comments / Version

SKU: 52115 Paging System
(WaveWare SPS-5)

The Paging Transmitter is a completely self-contained compact integrated POCSAG Paging
System. The system, which is comprised of a digital paging transmitter and embedded
paging encoder, is supplied with Windows® based encoder configuration software.
Connections between the PC and the SPS-5 Paging System are supported via a standard
(supplied) RS-232 cable.
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WaveWaré

SPSs”

PAGING SYSTEM

Figure 26. Paging Base Station

Physical and Mechanical

Dimensions: 9.0Hx85Wx2Din(22.9H x 21.6
Wx51Dcm)

Weight: Approximately 1.5 Ib (0.68 kg)

RS-232 Serial Com Ports

Single

Paging Message Types

POCSAG Tone/Vibrate, Numeric and Alphanumeric

RF Data Rate

512, 1200, and 2400 bps Auto-switching

Pager Database

5,000 PLUS, EEPROM

Interface Protocols

TAP, COMP1, COMP2, SCOPE or WAVEWARE
proprietary

Serial Port Configuration

300, 1200, 2400, 9600 Baud, Even/No parity, 7/8
data bits

Frequency

Frequency Source: Synthesizer
Frequencies: UHF2 - 440-470 MHz (US)

Frequency Stability: +/- 2.5 ppm

Operation Rating

Intermittent, 66% duty cycle

Power

Power Supply: 2VDC 3.75A AC/DC Adapter

Power Out (watts): 2 Watts (US)

Environmental

Temperature: O to 28° C (32 to 82° F)

Modulation

+/- 4 kHz (Wideband) or (Narrowband)

Bandwidth

Wideband (25 kHz) or Narrowband (12.5 kHz)

Transmitter FCC ID

UHF — MMASD225U2
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Arial Pager
Model Comments / Version

| SKU: 52112 | Arial Pager |
(Apollo AL924)

The Arial Pager is an alphanumeric device with a multi-line display and a zoom feature. Belt clip,
lanyard, safety chain and battery are included. Many useful functions include: silent alarm, pager on/off,
backlight on/off, auto sleep set, alarm and time set, selectable scroll speed, move to memo, delete one
or all messages, lock messages, 4 selectable beep sounds, 8 selectable melodies, plus vibration and
sleep mode settings.

Figure 27. Arial Pager

Specifications: Arial Pager

Physical and Mechanical Dimensions: 2.5 x 1.75 x 0.75in (6.35 x 4.45 x 1.9
cm
Weight: 1.9 0z (54 g); 2.5 0z (69 g) with belt clip
Input Frequency 457.6 MHz
Power 1 AAA battery, low battery alert
Display 4-line, backlit, zoom mode, date/time, battery level
Operation 3 buttons: Function, Select, Read
Attachments Supplied - Belt clip, lanyard, safety chain
Alert Modes Beep, Vibrate, Melody, Sleep
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The ADAM 6060 is used to connect to and control dome lights via TCP/IP communication
with the Arial Server and software.

Model Comments

SKU: 54180 (ADAM 6060) Digital I/0 Module with 6
Inputs and 6 Replay Outputs

SKU: 56107 (CUIINC SWI24-24-N-SC) Wall Adapter, 24

VDC, 1A, Class V1 efficiency

Pin Assignments:

RLO+
RLO-
RL1+
RL1-
RL 2+
RL 2-
RL 3+
RL3-
RL 4+
RL4-
N/A
(R) +Vs
(B)GND

(

Is0.GND
RLS-
RL 5+
DIs
Di4
DI3
DI2
DI
Dio

RJ45
(Ethernet)
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Arial Software Components

This section describes the Solution’s software components.

Arial Software

The Arial system is the next evolution of wireless nurse call, giving Assisted and
Independent Living Communities an advanced wireless platform for the safety and
security of their residents and the ease of use for their staff and caregivers. The Arial’
system incorporates the following key functionality:

*  Wireless communication platform for simple, cost effective, and flexible
deployments

* Consolidated event management, with alarm queues, dynamic maps, and
intelligent notification and messaging tools

* Advanced reports engine for tracking response times, compliance reporting &
resident system usage, with scheduled reports and automatic forwarding to email

* Event notification to mobile devices, overhead signs, and pagers

The Arial solution delivers several key benefits to senior living organizations:

* Improved performance: tracks response times & patterns across shifts to drive
higher levels of care

* Higher efficiency: pushes information directly to staff for efficient workflow

* Better resident experience: enables residents to call for help at any time.

The Arial system is designed to capture alarms and calls for help from wireless fixed
call stations. These alarms are displayed in the Arial software and optionally can be
sent directly to staff via a mobile app on a smart device, pagers or displayed on
overhead signs.

NOTE: The Arial system supports up to 3000 call points, but the number
of alarms that a Call Notification Station can display at once varies
depending on system settings and hardware. Once the number of
active alarms increases where they cannot all be displayed on a screen,
a scroll bar appears to enable viewing of the additional alarms. Alarms
are sorted by Category (highest priority on top) then by age (oldest on

top).

Larger facilities use multiple Call Notification Stations to display alarms.
Alarm points can be assigned to zones that match different areas of
responsibility covered by each Call Notification Station. This allows the
alarms that are relevant and actionable for care staff to be easily
available. See the Arial Administrator Guide for additional information
about using zones.

AeroScout Location Engine (ALE)
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The AeroScout Location Engine works with the Gateway GW-1000 to supervise the
server and sound a trouble signal when an outage is detected. Additionally, the ALE
communicates with the GW3X00 gateways and is used to calculate the location
information that is provided in Arial for pendant alarms.

Arial Mobile Application (Supplemental)

The Arial Mobile Application is a supplemental application designed to work
seamlessly with the Arial” Wi-Fi Wireless Nurse Call System to provide senior living
caregivers with an innovative tool for handling nurse call alarms and communicating
collaboratively with their coworkers. The Arial Mobile Application is packed with
intuitive features to ensure community caregivers have visibility to all relevant alarms,
their status and who is responding.
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Solution Deployment Checklist

The following section is for STANLEY Healthcare and authorized Arial partner
installers. Use the following checklist as a guide when deploying the Arial Wi-Fi
Wireless Nurse Call Solution.

IMPORTANT: System shall be installed in accordance with NFPA 99

Healthcare Facilities Code and NFPA 70 National Electrical Code.

IMPORTANT: Please read the important notes regarding backing up and

restoring before deploying the system. See Backing Up and Restoring.

Note: The order may vary according to the facility.

Steps Deployment Procedures

1 Set IP address of Arial and AES Server Network Interface that will be used for communication
with UL1069 Fundamental Equipment.

2 Arial software must be installed and configured according to the site.

3 Download, install and configure the AeroScout Location Engine.
See Deploying the AeroScout Location Engine.

4 Integrate Arial with the AeroScout Location Engine.
See Arial and ALE Integration.

5 Install Switches.
Install GW1000 and GW3X00 devices.
Install sirens (Model: 56108). See Installing and Configuring Sirens.

8 Wire Dome Lights to Gateways or ADAM Module

9 Configure Gateways to activate sirens. See Configuring Gateways to Activate Sirens.

10 Register Call Stations to Arial with descriptions to indicate the room and location where they
will be installed. Configure outputs to turn on dome light for call station alarms.

1 Install and Each Test Call Station. Verify Correct Dome
Lights llluminate. See Deploying Call Stations.

12 Verify all Call Stations were tested by viewing Arial Device Activity Report and comparing to
room list.
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Assigning IP Address for PC to Communicate on
Fundamental Network

1. Go to Control Panel of the PC where Arial Server and AES will be installed. This
procedure assumes the same PC will be used for both pieces of software.

2. Navigate to the IP Ver4 Network Properties Window

3. Choose Use the following IP address and enter IP address: 192.168.1.2 and
255.255.0.0 for the Subnet mask.

Internet Protocel Version 4 (TCP/IPv4) Properties X
General

You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

() Obtain an IP address automatically

(@) Lse the following IP address::

IP address: 192 .168. 1 . 2
Saretme
Default gateway: I:

Obtain DNS server address automatically
(®) Use the following DNS server addresses:
Preferred DNS server: I:
Alternate DNS server: I:

[Jvalidate settings upon exit Adyanced...

(o ][ om

4. Click OK to apply the change.

Note: This IP address is needed to allow the AES to be able to configure
the GW1000 and GW3X0O0 devices in later steps. The Gateways use
192.168.1.178 as its default IP address. If the customer’s network will be
involved and these IP addresses cannot be used permanently, they can

be changed once the gateways are added and new IP addresses are
assigned in later steps.
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Deploying the AeroScout Location
Engine

The Arial software communicates with a GW-1000 and GW-3X00 gateways over a
dedicated call nurse system network.

The ALE consists of the following components:

AeroScout Engine Server (AES): Designed to process and forward messages
between the GW1000 and GW3X00 gateways and Arial.

AeroScout Engine Manager (AEM): Administration and configuration tasks for the
AeroScout Engine Server are centralized in the AeroScout Engine Manager. The
AEM is used to configure network communication with the GW1000 and GW3X00
gateways.

The Arial Wi-Fi fundamental components must be installed on a
separate and dedicated network.

Important ALE Solution Deployment Notes

Mobile Units and other non-STANLEY Healthcare Wi-Fi components are not
supported

A HA (High Availability) setup is not supported

The Engine Server (AES) and Manager (AEM) can be installed on the same
machine as Arial

The ALE must be licensed using the STANLEY Healthcare support portal. See
AeroScout Engine Deployment Guide for more detail

All access points do not need to be added to the AES for Gateway-only
deployments

ALE Deployment Checklist

For full ALE deployment details refer to the following resources from the STANLEY
Healthcare knowledge base:

‘ KB # Document Name ‘

12271 AeroScout Location Engine 5.5.4 Deployment Guide

12274 Location Engine 5.5 MR1 for Non-Cisco Download
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Use the checklist below as a guide during the AeroScout Location Engine deployment
process.

Steps Deployment Procedures

1 Download the AeroScout Location Engine 5.5.4 MR1 software version for Non-Cisco.
2 Install the Engine Server (AES) and Engine Manager (AEM) on the same machine as
Arial Server.

Refer to the Location Engine Deployment Guide > Installing
AeroScout Location Engine in a Non-Cisco Environment & Installing AeroScout
Engine Manage sections.

3 Register the ALE in the STANLEY Healthcare support portal in-order to receive a
license.

4 Apply the license in the Engine Manager.

5 Configure the Engine according to the site’s infrastructure:

*  Setup Campus, Building and Floor
e Add Map
*  Mark 0.0
* Calibrate Map
*  Apply Calibration
* Add Cells
Refer to the Location Engine Deployment Guide > Defining Maps section.

6 Configure the Gateway 1000 and 3X0O0 devices on the maps in the Engine.
See Adding and Configuring Gateways in Engine

7 Configure the ALE Collection Time and
SNMP Trap Interval. See instructions in
this document.

Configuring the ALE Collection Time

The ALE Collection Time determines how long the Engine Server will wait to receive
the location data for a tag. After this timeout, the Engine Server starts calculating the
location of the tag.

Collection Time in the AeroScout Engine Manager (AEM) must be configured to 500
msec.

1. Open the AeroScout Engine Manager (AEM).

2. From the Menu bar click on Configuration and select Server Parameters >
System Parameters in the submenu.
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53 AeroScout Engine Manager
File Configuration View Actions Tools Help

b——

@ itPlybock Mode 2000 BB @

— Users >

Client Parameters

— Campus - MobileView Association

*8 Server Parameters > System Parameters
“ @ Main Bid [ Logger
« (@) g" Floor Asset Locator Filter
4 (g Main Floor [ID: 1] ; 2 5
08 Devices Tag Security Configuration >

3. Select the General tab.

4. Under Location Reports — Collection Window set the Collection Window time to
500msec.

Systemn Parameters X

General | Devices | Filters | Wi-Fi Devices | SNMP | Partners

Location Repaorts - Collection Window

Collection Window time (msec) for unidirectional tags:  |500

Location
[] Support tags attached to vibrating assets

Campus - MobileView Association
[] Multi Site Enable

Tag's LF Sensitivity Configuration

[] Enable Tag's LF Sensitivity configuration in Device Properties dialog
R55I Threshold Configuration

[] Enable RSSI Threshold configuration in Access Point Properties dialog

5. Click OK.

SNMP Trap Interval

When a device is down, such as a dome light, a trap is immediately sent from the
Engine to Arial, and then resent every 5 minutes (Engine default value). This default
value needs to be changed, in the Engine Server’s PeProperties file, to every 60
seconds (4 cycles) for UL1069 deployments.

The following procedure is for Non-Cisco (Standalone) systems only:
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1. Stop the AeroScout Engine Server.

2. From the Engine Server PC, navigate to the AeroScout Engine folder: C:\Program

Files (x86)\AeroScout\AeroScout Engine
3. Locate and open the PeProperties.properties file.

4. Scroll down to [SNMP].

5. Set the ‘SnmpSendDevicesStatusCount’ parameter to 4 and save the file.

FNUMDEr o NMP_check =
snmpSendDevicesstatusCount=4
#5ets the connection timeout. This ti
TcpTransportConnectionTimeout=120000

6. From the Engine Server PC, navigate to the AesBackup folder: C:\Program Files

(x86)\AeroScout\AesBackup
7. Locate and open the PeProperties.properties file in the backup folder.
8. Scroll down to [SNMP].

9. Setthe ‘SnmpSendDevicesStatusCount’ parameter to 4 and save the file.

FNUMDEr o NMP_check =
snmpSendDevicesstatusCount=4
#5ets the connection timeout. This ti
TcpTransportConnectionTimeout=120000

10. Restart the AeroScout Engine Server.

Location Engine Map Configurations

The following steps must be completed in the Location Engine before continuing:

Make sure the facility and resident floors have been defined.
Browse 1?| i Data l Repository I Info ‘
“ @Site
“H Campus 1
Campus 2
I 5 Campus 3
4 [H Senior Living

4 [{5) Resident Building
(1) Resident Floor

Make sure the GW1000 has been added to a map in the AES.

The map is a central element of the Wi-Fi based system. Maps are used to mark
the position of installed devices across the site and to monitor the Wi-Fi Devices
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and Tags moving within the site. A map represents one floor or part of a floor. One
floor may include several maps.

See the Arial Administrator Guide for Version 10.6 MR1in the Knowledge Base
Article #12137 for additional details about adding maps in Arial.

Note: One map which can be any .png, .bmp or jpg file with the
GW1000 placed on it is required. The GW1000 is used as a watchdog
appliance for the Arial Server.

Steps for Adding Maps in AES

Note: For Wi-Fi deployments, maps that are drawn to scale are
required. Accurate maps and precise placement of Gateways on maps
in the following steps is required to help produce the most accurate
location of pendants and other portable devices when the installation is
complete.

1. Animage file for the map must be saved to a known drive location on the machine
running AES, typically somewhere on the C: drive. Accurately scaled drawings are
required.

2. Open AEM and connect to AES by selecting the File menu, then Connect to AeroScout
Engine Server.
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E.-Ia AeroScout Engine Manager
File Configuration View Actions Tools Helg

Connect to AeroScout Engine Server
Logout

Download Recordings
Download Logs
Backup Configuration

Restore Configuration

Exit

3. Enter the Admin User Name and Password. If the AeroScout Engine Server (AES) is
installed on the same machine as the Arial hardware and the AeroScout Engine Manager
(AEM), the Host Name / IP Address can be setto 127.0.0.1. If the AES is installed on a
different system, use the hostname or IP address of the other system.

EZ Connect to AeroScout Engine Server
User Name: |hdmin I
Password: R

Host Name / IP Address: 127.0.0.1
Port: 1411

Remember me

| ok || cancel |

4. Add Campus, Building, Floor, and Map by right-clicking and selecting the option to add
each layer staring with Site under the Browse pane. The final layer will be Add Map.

r‘a AeroScout Engine Manager
File Configuration View Actions Tools Help

Templates Data Info m

Browse ? Repository

4 gpsite

4 g"jCarnpus

4 E Main Bld

() Mair
Collapse
‘ Add Map

Remove

Properties

Upload Device Firmware
Associate Device Template
Status All Access Points
Status All Devices
Properties All Access Points

Properties All Devices

5. Enter a Name for the Map in the dialog that appears, then click OK.
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(3 Add Map

Name: ‘Main Floor

X

| oK

‘ ‘ Cancel ]

6. Browse to the location where the map file was saved using the window that appears.

(3 Open
A &> ThisPC > Pictures » v

Organize ¥ New folder

N

@ OneDrive
—

8 This PC ~=
¥ 30 Objects
[ Desktop ~=
D Documents Camera Roll Saved Pictures
¥ Downloads
D Music
& | Pictures
B Videos
= Local Disk (C:)
s STANLEY (D:)

v

File name: | Map1

Image files (*.bmp;*.gif:" jpg,"§

7. The map is displayed in the large section of the window. Right-click on a location on the
map (typically the lower- left corner) and select Mark 0,0 from the menu that appears.

| Replace Map Image

Mark (0,0)
Calibration
Apply Calibration

| Cancel Calibration

8. Locate a hallway or other longer length span on the map where the distance is known
between two points. Right-click at the first point on the map image where you know the
distance to another point. Select Calibration > Calibrate Distance from the menus that

appear.

Replace Map Image
Mark (0,0)

Calibration
Apply Calibration

Cancel Calibration

] l Calibrate Distance
Calibrate Paoint
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ﬂ £ Type here to search

9. Click and hold to draw a line to the second point on the map where the distance is
known.
[ AeroScout Engine Manager - x
File Configuration View Actions Tools Help
QAREI EEN /06 6RE6EEE sTARLEY
e Dete OB corcecaro 001 |
B:wae T Repository
4 EpSite |
e !
(@) Main Fior -
i
|
{63} System Confiquration L ek L Aot i
@CDvemgeAnalymr 1 N - : ‘ i
& Accuracy Ana ; ST J@{ ¢ |
e o hrshvzer 1 = Replace Map Image ! !
|2 Radio Map Generator I Mark {0.0) l e | !
: i A Calibration v|[ [ calibrate Distance |
O i i H Apply Calibration | Cairate Point ! !
HJ Engine Traflic Log 5 | Cancel Calibration T | !
¥ S ® \ | Panores.

10. Enter the distance between the two points in meters in the dialog window that appears.

Click OK.

[E Distance Calibration

Distance (m):

| ok

| | Cancel

11. Right-click on the map a final time, then select Apply Calibration.

Replace Map Image

Mark (0,0)

Calibration

Apply Calibration

Cancel Calibration

12. Verify your map appears under the floor in the hierarchy under the Browse pane.
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% AeroScout Engine Manager
File Configuration WView Actions Tools Help

QRAQAQA@EO @EOw

Templastes |  Data | co
Browse ? Repository
4 @Siﬁe
4 @Campus
4 [ Main Bld

4 [ 0) Main Floor
| g Main Floor [ID: 1]
—

13. Right-click in the map then select Add > Add Cell.

| Add » Add Device
Edit Cells Add Access Point
Edit Masks Add Reference Point
Calibrate Map | Add Cell
Remove Map Add Mask
Map Properties |

14. Draw a cell around the perimeter of the map. Make sure to close the cell.

5B AeroScout Engine Manager - 8 x
Fie _Configuration View Actions Tools _Help
RAQEO HEL| DL 06 SBIEBEE STANLEY.
Tewois | Dua | o | FSTrY TR 00
Browee Reposiory
Prc i 3
‘ ‘?ﬁf.ﬁi B

4 () Main Floce
4 [ Main Floor [ID: 1)

<1 System Configuraton

€9 Coverage Analyzne

(& Accuracy Analyzer

2] Radio Map Generaior

4] System Diagnostics

(i Engine TraficLog

ﬂ/onpebeve(osearch ) m o I w g

Deployment & Maintenance Guide

70



Arial Wi-Fi Nurse Call Solution

15. Enter a Name for the cell in the space provided, then click OK on the Cell Properties
dialog box.

L cel Properties

MName: Main Floor Cell 1|

Cell Perimeter
The Pasitioning search area is defined by the Cell Perimeter:
Coordinates

# X Y

1 1.93 7.85
2 1045 754
3 1043 511
4 10.86 5.1
5 1093 3.25

Cell Members
Only location reports fram Cell members are used for location calculation inside the Cell perimeter:

Cell Members Non Members

16. Repeat the steps above to add buildings, floors, and maps for all resident areas of the
campus.
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Arial and ALE Integration

The following section explains how to integrate Arial software with the AeroScout
Location Engine. The integration is done after the ALE deployment.

Applying the UL1069 License in Arial

Arial must be licensed for UL1069 to set defaults in the software to match
requirements for UL1069. The following procedure must be performed by an Arial
Administrator.

1. Install Arial and HPS Server on the PC that will act as the Arial server (if this has
not been completed already). Refer to the latest version of the Arial Software
Installation Guide for requirements and steps to install the newest version of
Arial.

2. An Activation Code and License File are required for this procedure. They are
generally supplied on a USB drive included with the system. Contact Technical
Support at 800-380-8883 if you need assistance locating these files.

3. Launch Arial and login as an Admin if needed. Go to System > System > Server,
then click Update License.

e Arial’

Home Reports  System

Arial  EventCategories System  Notesand Procedures TranspotReasons  Site Profle  UserDefined Fields  Server

@ Infrastructure \/

Save

'\g Users Server Information

) Healthcare Platiorm Server Demo Edition. Version 6.18.0
(=) Messaging System Code:
PCs: 1
U oros DB Server ROOFSIMBIXMARK
DB User hps
PC Name ROOFGIME
. Address: 192.168.1.2
B Tranemiters Operating Systern  Windows NT - Version 6.02
Total RAM 11993 M8

Working Path C:Program Files (x86)Healthcare Platform Servert

Fy
> Y

._ﬂ Apartments

3

F| Schedules

7
| ¢) Reminders
Connected to 0 Browser Client(s)

R, egrosic
NumberConnectedCliens Shutdown Wink
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4. A Check License window opens. Locate your Activation File and copy the
System Code and paste in the System Code area, then copy the Activation Key
and paste in the Activation Key area. When finished, click Activate

# Check Licenss

®
Ligense Info - -
System ID 0 SUSPENDED  [ays left. [ |
@ Products | Marmenance By Date:  [4796:2081
Edtior:
Liceran kfa:

Refrmsh
Actrwation

System Code: 3
Acwwation Key :

2 | |II | 2940707-1 2630373671 2601 JGE27-1001 34745 1-1243374007-1112959395

T teae |

C\Frogram Fiea G863 Hoakhcam Mlarfoms Sorvertpsa f

If a dialog appears prompting you to Restart Healthcare Platform Server, click OK,
but do not restart just yet.

Healthcare Platform Server x
The license file has been updated.
Please restart Healthcare Platform Server for the new settings
to take effect.

6. Click Browse next to Update License File and locate the .lic file for your system
with the provided license information, then click Open on the Open window.

4 |« STAMLEY (D) » UL256D License
Orgenize = Mew folder

& Onelrive

Datema Trpe
2 sk ARTOLic TR T s
¥ 30 Objects
[ Deskiop
< Documents
& Downloads
I husic
| Pictures
B videcs
e Lacal Disk ()
— STANLEY (D)
v < .
File name: 23731 7913.ic

< | License [*lic})

Dpen Cen
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7. Click Update.
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# Check License

Licenss Info
System 1D
ﬁ Products:
Ecition:

License Info:

At s
System Code:
Aciivabion Key :

Licwnaing / Uipdates
lUpdate Leanse Fle
System ID:
Margenance Expiry Date :

License File Info:

[Ammme || AaTveE |

dal | Manisnance By Date:  [712/2020

Hasstheare Platfoam Server (Professsonal) ]

Musnber of WG B Controllens: 55
Mumbser of Third Party Inberfaces: &

[T

| 1T 540707-1 6383736 T- 1 2501 3662 T- 180N M4 T4 1 24 1374007111 2555355

| DAULISED Lcenae\ JATI TS0

FERE L LE | Producs: [ay

[415203

C\Program Files (38 Healthcare Platfom Senveross i

[ thsse ||
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8. If a dialog appears prompting you to Restart Healthcare Platform Server again,

click OK, then click Close to close the Check License window.

9. Shutdown Arial by clicking on the main STANLEY Menu in the upper left corner

of the Arial window, then select Exit.

)

Admit

View
Language
About
Help

0 Exit

Modify Screens

»
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10. Restart the PC by clicking on the Windows Menu in the lower left corner of the
PC screen, then selecting Restart under the Power options.

e Administrator

[ Documents
J Sleep
(D Shut down

) Restart

Power

£ Type here to search

11. Wait for the PC to shutdown and boot back up. Arial should load after a few
moments. Log in as an Admin if necessary, then navigate to System > System >
Server and verify UL1069 appears as a listed license item.

STARLEY. Arial

Home Reports System

Anal  AmalMobde EventCategones Systern  Notesand Procedures TransportReasons  Site Pro

A ’
w Infrastructure b4
Save
3 Usery Server Informason
I— Healthcare Platform Server Demo Edibon, Version 6.180
.,__J Messaging System Code
PC's: 1
I Number of WG Blue Controllers: 99
Zones

Number of Third Party interiaces: 8
Thard Party Interface { WanderGuard BLUE / Nurse Call / ALE / Mobde App | Enhanced Locate *

Anal
@ Tronsmiters DB Server ROOFOIMBIXMARK
- D8 User. hps
t’i. Devics T PC Name ROOFIIMB
I it A e Address 192.168.1.2
Operating System:  Windows NT - Version 602
L Total RAM 11993 MB
u Apartments Working Path C/\Program Files (x86) Healthcare Plaform Server\

12. Click Home to return to the Main Arial Screen.

Configuring Arial for ALE
The following procedure must be performed by an Arial administrator.

1. Login to the Arial software.

2. Click on the System tab.

3. Select Infrastructure.
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4. Click on the ALE tab.

A% Shin NetworkDevices \WanderGuardControllers Gateways PagerStatons 10 R3N
ys

' ALE (0) -
| @9 Infrastructure 1 Name
8 Users

Home (700) ReportslSystem I
ks R3Controlk Spectralink  FieldServer mro

‘9 Maps
5. Click Add.

Home (700) Reports System

System
ALE (0) — — —

e

& NetworkDevices \WanderGuardControllers Cateways PagerStatons 10 R3N\ R3C S| link FieldServer TekTone ALE

";ﬁ Apartments

&9 e

6. Under the General section perform the following:

a. Enter in the Description as ALE.

b. Enter in the IP Address of the ALE Server (use 127.0.0.1if AES is
installed on same machine as Arial Server software).

c. Enter in the Port (Default is 1411).

d. Enter in the User and Password for the ALE.

e. Check that system Status is Connected.
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f. Leave Event Configuration as is.

Home Reports  System

Q Notwock Devices  Warder QuardCorpoliens  Oateways  PagerStitors 10 RiNewsrks  RiCoovolens  Spectaivk  FwldSerw  TekTone  ALL

(MEM
|
m] =

ALE arw wm 201702 84T 22901 (0 Comnected

127001

14n

aderon

7. Click Save.
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Adding and Configuring Gateways in
Engine

Note: Gateways must be connected to the network one at a time when
completing the steps in this section.

The following sections explain how to add and configure Gateways in the Engine.
Refer to the AeroScout Location Engine Deployment Guide for more details.

Adding the GW1000 Gateway

One GW100Q0 is required on the Arial system. This gateway is used to detect
messages from call stations, pendants, and other Wi-Fi transmitters. In addition, the
GW1000 serves as a watchdog appliance to monitor the Arial software. In the event
that Arial is not running, the GW1000 can activate a siren to draw attention to the
outage.

1. Connectthe GW1000 to the Arial network and allow it to boot.
2. Click on the Repository tab, then click on the Scan button.

L-'a AeroScout Engine Manager
File Configuration View Actions Tools Help

QAR Q@ @EO=l
 cd

Templates Dﬂtﬂ‘l Info
T ? Repository |
HE - @ =
MAC Address 2|D| Scan Parameters I_

3. Click on the Scan button on the Repository Scan Parameters dialog that
appears.
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[ Repository Scan Parameters X
IP Address search range:
Last updated: Tuesday, April 13, 2021 3:57:23 PM v
92 68 78| - | 192 168 78 | Port: 1511
[ Scan | I Save ] [ Cancel I

4. After a moment, verify a new device with Device Type of GW1000/GW1200
appears in the Repository. Confirm the MAC Address matches the one listed on

the label on the back of your gateway.

% AeroScout Engine Manager
File Configuration View Actions Tools Help

5. Click OK on the Add Device dialog box.

QAQRED EEO L

Tempistes | Data | o |
Browse ? Repository
e s @ ]
MAC Address |Da'ﬂee Type
[fooocccessrai GW1000/GW1200 |

@ Add Device X
Device Type: GW1000/GW1200
Device Template: No Template v
OK || Cancel
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6. A Device Properties dialog box appears. Verify the boxes for Enable Wi-Fi
Receiver 1 and Receiver 2 are both checked, then click OK.

[] Device Properties

General Settings | Wi-Fi

Identification

m} x

Device Name [ooocicciesira

Map: Main Floor [17_1_0]
Template Name: No Template
Pasitioning Parameters

Coordinates (meters): X |885 Yo 761

Network Configuration

MAC Address: 00 | |0C ||CC | |65 |[5F | |31
IP Address: 192).|168|.| 1 |.|178

| Connected to Network

Device Parameters
Device Model:

Unknown Device Type:

Enable Device LEDs

Enable Wi-Fi Receiver 1
Enable Wi-Fi Receiver 2

Comment

Z [3.00

Port: 1511

GW1000/GW1200

7. Ablue icon for the Gateway where you placed it on the map appears. Right-click

the icon and select IP Settings.

Ping
Restart
IP Settings

tatus
Enable b

Save Az Template

Properties

Remaowe

8. A TCP/IP Settings dialog box appears. Enter an IP Address for the GW1000 that
will be unique on the network segment being used (see note below). When
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finished, click OK.

Device: D00C:CCeRIR3TNM 3 N
MAC Address: 000CCCASSF31

Cbtain an IP address automatically (DHCF)
®) Use the following IP address

| 1P Address: (105 ].[168].

@ TCP/IP Settings X

1 |.[7en] |
Subnet: »55 . 2550 o |l ool
Gateway: 197 sl 1 [ 1]
Listening Port:  |1511
Destination Port: 12091
| OK | ‘ Cancel |

Arial Wi-Fi Nurse Call Solution

Note: If you are continuing with 192.168.1.2 for the AES PC, then you can
change the last byte of the IP so it is no longer .178. This helps prevent
problems if another Gateway needs to be added in the future. If you
will be changing the IP address of the AES PC, then the IP Address,
Subnet, and Gateway need to match the requirements for the LAN you

will be using.

@ TCP/IP Settings

MAC Address: 000CCC655F31

® Use the following IP address

IP Address: 107 .| 1482
Subnet: 255/ ./ 255 |.
Gateway: | 192 !.! 188

Listening Port: 151N
Destination Port: 12091

Device: 00:0C:CC:65:5F:3111D: 3 91

Obtain an IP address automatically (DHCP)

OK

Cancel
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9. The gateway should still appear on the map. It will be blue in a few moments if
the PC and the Gateway are both using 192.168.1.X IP addresses. If this is not the
IP address range you programmed, then the Gateway will not appear blue until
you change the IP address of the AES PC in the control panels. You will want to
wait until all GW3X0O0 devices are configured before changing the AES PC IP
address.

10. The Gateway is added.
Adding the GW3X00 Gateways
1. Connect the GW3XO0O0 to the Arial network and allow it to boot.

2. Click on the Repository tab, then click on the Scan button.

E.-'Q AeroScout Engine Manager
File Configuration View Actions Tools Help

QACE O EEO=

Templates Dat§1 Info  cd
Browse ? Repository |
3315, @ :
MAC Address 2|D| Scan Parameters L

3. Click on the Scan button on the Repository Scan Parameters dialog that
appears.

@ Repository Scan Parameters X
IP Address search range:

Last updated: Tuesday, April 13, 2021 3:57:23 PM w

02|.|/168 . ; 8| -|1192|.(168|.| 1 |. 3 | Port:

| Scan l ‘ Save || Cancel l

4. After a moment, verify a new device with Device Type of GW3000 appears in
the Repository. Confirm the MAC Address matches the one listed on the label
on the back of your gateway.
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% AeroScout Engine Manager
File Configuration View Actions Tools Hi

QACH O HEN =

Templates l Data l Info
Browse ? Repository
1 3] JC 38 .
MAC Address IDe\noe Type
CCC6625C0 Gw3100

5. Click OK on the Add Device dialog box.

@ Add Device X
Device Type: GW3100
Device Template: Mo Template ”‘ |
OK || Cancel |

6. A Device Properties dialog box appears. Uncheck the boxes for Enable Wi-Fi
Receiver 1 and Receiver 2 then click OK.

Device Properties - O x

General Settings | Wi-Fi

Identification

Device Name foociccigeizs:co
Map: Main Floor [17_1_0]
Template Name: No Template

Positioning Parameters

Coordinates (meters): X Y Zz

Network Configuration

MAC Addres: o]

1P Address: [ee]. [ ].[178] Port:

/| Connected to Network
Device Parameters
Device Model:  Unknown Device Type: [ Gwz100 ¥]
Enable Device LEDs
Functicnal Modules

Enable Wi-Fi Receiver
Enable BLE Receiver

Comment

[ |
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An icon for the Gateway where you placed it on the map appears. Right-click the
icon and select IP Settings.

oy 9 Disable »
Bt
'ﬂ.""

g KT Save As Template

g Remove
t_ﬁ tl

Ping
B Restart
5 | 1P Settings |

Status

Properties

A TCP/IP Settings dialog box appears. Enter an IP Address for the GW3X00 that
will be unique on the network segment being used. When finished, click OK.

Note: If you are continuing with 192.168.1.2 for the AES PC, then you can
change the last byte of the IP so it is no longer .178. This helps prevent
problems if another Gateway needs to be added in the future. If you
will be changing the IP address of the AES PC, then the IP Address,
Subnet, and Gateway need to match the requirements for the LAN you

will be using.

Device: 00:0C:CC:p6:25:C0 MID: 3 21
MAC Address: 000CCC6625C0

() Obtain an IP address automatically (DHCP)

® Usze the following P address
IP Address: (g2 . 1/8 1. 1 |. 1n1|
Subnet: 2551255, 2550.0 0
Gateway: | 102|. 168 0.0 1 |.] 1

] Apply Wi-Fi Settings

S51De

Security Type: Coen

Listening Port: 1511
Destination Port: 12091

@ TCP/IP Settings X

QK | | Cancel
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9. The gateway should still appear in on the map. It will be blue in a few moments if
the PC and the Gateway are both using 192.168.1.X IP addresses. If this is not the
IP address range you programmed, then the Gateway will not appear blue until
you change the IP address of the AES PC in the control panels. You will want to
wait until all GW3X0O0 devices are configured before changing the AES PC IP
address.

10. The Gateway is added.
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Installing Gateways

Position and mount each GW3XO00 in the site according to the site survey recommendations.
The attached Siren needs to be placed where caregivers can hear the alarm should a system
failure occur.

GW3X00 Wall Mounting Parts

Part Part Name Qty Image
Letter
A Tile Mounting 1
Bracket (with
Latch)
B Wall Mounting | 1 R
Bracket
(& 2 Hex Bolts & 2
Nuts
%)
D Wall anchors ﬂ
and screws ‘ i

Mounting the Gateway on a Wall

1. Place the Wall Mounting Bracket (B) with its back on the wall in the desired
mounting location. Make sure to align the Wall Mounting Bracket's (B) cable
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cutout so that there is enough cable length to connect the Gateway.

SN\

Cutouts

2. Mark the 4 screw holes.

Screw holes

3. Drill the 4 screw holes in the wall and tap in the wall anchors. Do not screw the
Wall Mounting Bracket (B) into the wall at this time.

4.  While the Wall Mounting Bracket (B) is still off the wall, insert the short hex bolts
(C) through the bolt holes on the back of the Wall Mounting Bracket (B).

5. Place the Wall Mounting Bracket (B) with the hex bolts extended outward on its
wall mounting location and aligned with the wall anchors.

6. Screw the Wall Mounting Bracket (B) into the wall anchors with the wall screws (D)
in place and tighten. The two bolts should be facing straight outward when done.
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7. Place the Tile Mounting Bracket (A) over the Wall Mounting Bracket (B) and
tighten with the hex bolt nuts.

8. Attach the Gateway to the RJ45 cable.

9. Place the Gateway over the keyhole mounting clips of the Tile Mounting Bracket
(A).
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10. Slide the Gateway onto the Tile Mounting Bracket (A) until it clicks into place.

11. The Gateway can be removed from the Tile Mounting Bracket (A) using the
bracket’s Latch. Push the Latch to the side and slide the device off the Tile
Mounting Bracket (A).

Note: Alternative mounting kits are available if the Gateway must be
mounted on a drop ceiling.
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Installing and Configuring Sirens

Sirens (Chimes) are configured to produce a distinctive chime tone for alerting staff to

Server and Client application failures.

* The Arial Wireless Nurse Call Solution requires the installation of a siren for
monitoring for Server failure. The siren will be connected to a Gateway GW1000.

* The GW1000 Gateway is configured in Arial to trigger the siren when the Arial
Server Software or PC is not communicating with the gateway, such as occurs
when the software or computer are not running.

Connection Notes:

* Asiren used for HPS Server failures MUST be connected to the Gateway’s Relay

(N.C Terminal).

See Appendix for Wiring Diagrams for the GW1000 and Sirens.

Selecting 56108 Siren Audio

Each siren has a rotary switch for tone and volume selection on the back of the unit.

Each siren must be set to position 4.

AUDIO SELECT

Setting Repetition Rate dB Level
1 1 Second Chime High
2 1 Second Chime Low
3 Y2 Second Chime High
4 ¥ Second Chime Low
5 Temporal Chim High
6 Temporal Chime Low
7 5 Second Whoop High
8 5 Second Whoop Low
9 Coded™ High

**For chime only.
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Mounting a 56108 Siren

Sirens (Model: 56108, CHWL) can either be mounted over a gang box or wall mounted
using a Wall Surface Mount Back Box (Model: 56109, SBBWL). In both cases a
standard mounting plate is used.

Wall Mount Siren with Wall Surface
Mount Back Box
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56108 Gang Box Mounting

1. Attach mounting plate to junction box. The standard mounting plate is compatible
with 4" square, single gang, double gang, and 4" octagon junction boxes.

2. Connect field wiring according to terminal designations. The siren only requires
two wires for power and supervision.

NOTE:The Shorting
Spring must be fully
engaged. It is therefore
recommended to use the
far Right plus (+)
terminal.

WIRING TERMINALS
1. Negative (-). Line in and out
2. Positive (+). Line in and out
3. Positive (+). Line in and out

3. Ifthe sirenis not to be installed at this point, use the protective dust cover to
prevent contamination of the wiring terminals on the mounting plate.

4. To attach the siren to the mounting plate, hook tabs on the top of the siren
housing into the grooves on mounting plate. Then, hinge the siren into position to
engage the pins on the siren with the terminals on the mounting plate. Make sure
that the tabs on the back of the siren housing fully engage with the mounting
plate.

5. Secure the siren by tightening the single mounting screw in the front of the siren
housing.

Tamper Screw
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For tamper resistance, the standard captive screw may be replaced with the enclosed
Torx screw.

1. To remove the captive screw, back out the screw and apply pressure to the back of
the screw until it disengages from the housing. Replace with the supplied Torx

Screw.

56108 Surface Mounting

The optional 56109 surface mount back box may be secured directly to the wall
or ceiling. A grounding bracket with ground screw capability is provided if

needed.

1.
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2. The wall mount box must be mounted with the up arrow pointing up.

3. Threaded knockout holes are provided for the sides of the box for 2 inch conduit
adapter. Knockout holes in the back of the box can be used for Y2 inch rear entry.

4. To remove the %2 inch knockout, we recommend you use a flat head screwdriver,
place the blade of the flat head screwdriver in the inner edge of the knockout.
Strike the screwdriver as you work your way around as shown below.

NOTE: For % in. installation, use caution not to strike the knockout near
the top edge of the surface mount back box.

5. V500 and V700 raceway knockouts are also provided. Use V500 for low profile
applications and V700 for high profile applications.

6. To remove the knockout, turn pliers up, as shown below.

Wire Mold Removal

NOTE: Use caution not to strike the knockout near the top edge of the
wall version of the surface mount back box.
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Siren 56108B Mounting Instructions

1. The siren is designed to mount to a 2-inch-deep single-gang electrical box.

2. Route two-conductor cable from the GW1000 to the electrical box.

3. Connect the two wires from GW1000 to the positive (+) using the red wire and
negative input (-) using the black wire to the marked terminals on the siren. See wiring
diagram in appendix.

Connect wires — red to +, black to -

4. Secure the siren to the electrical box with the two supplied machine screws.

5. Insert cable into electrical box. Align siren screw holes to holes in electrical
box.
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6. Secure siren to electrical box with supplied screws.
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Configuring Gateways to Activate Sirens

The following section explains how to configure the GW1000 Gateway’s output
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settings in Arial for HPS Server supervision. These settings activate the siren when an
essential program service has failed on the Arial HPS Server.

This is a UL2560 requirement.

Prerequisites

* The siren must be connected correctly to a Gateway.

* The Gateway connected to siren must be added to the ALE.

* Gateway must be added to the ALE map.

* Arial and ALE must be integrated and correctly configured.

Configuring HPS Server

1. Open Arial and navigate to

Supervision

System > Infrastructure > 10.

STANLEY.
Reatnisre

Home (2) Rpporl«
v NebworhUevwot  Wander Guard Conbroliers

& E
System
JO (1)

Arial’

Galeways FAwlSIaNI'.{Ne:me R3Conyolers  Spechaluk  FmidServer  TekTone  ALE

m i
[Gv1000

3 Users

U rMessagirg

Lu Zanes
. Transenitioes
&
2] Device Types |

Wi || LS

Save Add Delete

3 e
Ceneral

f—jl Schndules Descripion  GWI000

1P Addemes
iy oo

Davnes 1D
>
\’_‘) Reminders Channeh

Q Channel  Descripton | State

" Disgnostics Oulput 1 Oulput1
Quiput 2 Oulput 2
Culput 3 Output 3
Output 4  Outputd
Qutput 5 OutputS
Output & Output6
Output 7 Output 7
Output 8 Outputd
Outpat 9 Output
Quiput 10 Output 10
Oulpul 11 Output 11
Output 12 Output 12
OQutput 13 Output 13
Relsy 1 Relsy |
Relay?  Relay?

2. Select the Gateway (IO) that you want to configure for ‘Supervision Alert’.

3. Under the Channels section, select Relay 1 which is the relay that is connected to

the siren.
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STANLEY.
Home (2000) Reports | System
G”""" MewakDevioss  WandecCuasConvobss  Golsways  Pagec

3

Y

Wz

Ariat =

Satore | 0| ANewots  RIConvolers Soewik  FscSenss Tollone  ALE

@ e
a— [ljgile]
||
e
f T P-—.
R <o

@ |[EE
oo (lLimes o

Deve b

'\’D Reorsndet Cuput 2 Cupee2

i1 e
Do || s cvens
Fourtd

Fliey 1 Raley t
Reisy2  Feiny2

2450m

4. Select the Supervision Alert checkbox.

5. Click the Save button on the 1O tab.

Qi

L I

e Add to Map
Delete

| % Device Types Save Add
1 neral
tﬁ Apartments
Description GW1000
@ Maps IP Address 192.16!
— Device ID 35

=]

q —
STANLEY. Arial'
Home (2) Reports | System
@ S NetworkDevices WanderGuard Controllers  Gateways  Pager Stations \E\ R3Networks  R3Controllers TekTone ALE
& |
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Deploying Arial Wi-Fi Call Stations

These wireless, battery-operated fixed-location devices are designed to trigger an
alarm when the call button is pressed, the pull cord is pulled, or when an optional
remote push-button is used.

This section applies to the following Wi-Fi Call Station models: CS100, CS100MR
CS100CD, CSK200 and CSK200-MR.

Activating the Call Station

Call Stations are activated when batteries are inserted, or an external power supply is
connected and remain in Standby mode with a default transmission rate of 120sec. A
Call Station activation message is transmitted to Arial.

Call Station Alerts

Pressing the Call Station’s call button triggers an emergency message that is sent to
Arial and changes the Call Station’s status to Alarm Mode. The Call Station remains in
Alarm mode (flashing red LED) until the alert is physically dismissed.

Dismissing Call Station Alerts

Alarms are dismissed by staff members at the device that triggered the alert, by
pressing on the Call Station’s Dismiss/Check-in button. A confirmation tone is heard
and LED stops flashing red. Dismissing an alert sends a ‘Reset’ message back to Arial.

NOTE: An alarm dismissed in Arial will reoccur until the alarm is
dismissed at the actual Call Station that triggered the alert.

Batteries and External Power
The Call Stations are supplied with three (3) CR123A batteries pre-installed.

Note: We strongly recommend that you remove the batteries if the Call
Station will not be used for an extended length of time.

Preparing the Batteries

The battery isolation strip must be removed from the battery compartment prior to
Call Station operation.
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